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2. Introduction 
 

 

This document contains all of the information needed to install, set up, and run the American Miniature Horse 
Association Show Program.  The major categories are as follows: 
 
 
How Do I Get Started? 
 
How Do I Get To Know The System? 
 
How Do I Set Up A Show For The First Time? 
 
How Do I Manage My Entries During A Show? 
 
How Do I Enter Results? 
 
How Do I Manage Things After A Show? 
 
How Do I Get Ready For The Next Show? 
 
How Do I Print Listings? 
 
How Do I Manage Database Repair/Maintenance? 
 
Is There Anything Else I Need To Know? 
 
I Need Help 
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3. How Do I Get Started? 
 

 

In order to use the Show Program, you first have to obtain the Show Program.  This is easily done with a 
phone call to the American Miniature Horse Association office.  Soon after doing this, you will receive an email 
with a link and password where you can download the setup program.  Complete details on downloading and 
installing the program are in the document "'Installing the AMHA Show Program.pdf'. 
 
 

3.1. Running The Program 
 

 

The installation program will have created shortcuts on the desktop and the start  menu.  Double click on the 
shortcut to start the program.  You should see something like this: 
 

 
 
 
 
At this point, you will want to select the folder for the show you're working on.  Even though we only show 
one show here ("My first show"), you can and probably will have multiple folders, one for each show. 
 
Double click on the "My first show" folder.  Your screen should now look like this: 
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Now, click the "Select database location" button and it will take you to the main splash screen: 
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Pretty plain, isn't it?  It's time to make it look like yours! 
 
How do I set up a show for the first time? 
 
 

4. How Do I Get To Know The System? 
 

 

This includes the following: 
 
Overview of the system 
 
Deployment of the system 
 
Tables 
 
Moving through the tables - Using the Database Navigator 
 
Locating records 
 

4.1. Overview 
 

 

The AMHA Show Program is a personal computer system based database system designed to maintain horse 
show information for the American Miniature Horse Association.  It is a windows-based, graphical system 
which allows for the maintenance of ownership records, horse information, entries, and classes. 
 
This system is highly customizable.  The owner accounting information has been designed to allow you to 
customize the entries to suit your particular show’s needs.  You can also import information from a previous 
show (such as classes) to avoid having to re-enter information. 
 
The system is activated by double-clicking on the system icon.  A splash screen will be displayed, showing the 
main menu.  This menu gives the client access to entry screens, report options, and system utilities.  The 
entry screens consist of both standard entry and “tabbed notebook” forms.  To switch pages on the tabbed 
notebook forms, simply click on the desired tab. 
 

4.2. Deployment 
 

 

This system is deployed electronically using a file sharing account.  Contact W. Mark Anderson Computer 
Consulting for the file share location and password.  Instructions are located on the file share. 
 

4.3. Tables 
 

 

All of the information used in the system regarding horses, owners, classes and entries are stored in objects 
called tables.  The system allows for two different types of tables:  Paradox and MS-Access.  These tables hold 
what would be considered the “normal” information required for a show, such as owner name and address, 
horse name, what classes a horse is entered into, etc. 
 
Even though there are very few “required” fields in the system, you will have greater functionality if you 
provide as much information as possible.  For example, on the Master Class entry screen, there is a drop-
down field called “approved sexes”.  This field lets you indicate what sex of horse is allowed in this class.  For 
example, there may be a class where only mares are allowed to enter.  While you don’t have to fill this field in 
for the system to work, filling it in allows the system do check to make sure that only eligible horses are 
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entered.   
 
The tables talk to each other by “relating” to each other.  For example, in the horse table, there is an entry 
(called a “field”) for the owner Id number.  In the program, this owner Id number in the horse table is used to 
lookup an owner in the Owner table and obtain information about him/her, such as the name, city, etc.  This 
is how on the horse screen, we can display the owner name without having to store it with the horse each and 
every time. 
 
By using these “relations”, we can view all of the given information in different ways.  For example, we can 
look at classes, and by relating the “entries” table, we can see the entries that belong to a particular class.  
Or, we can look at owners, and by relating the “horses” table, we can see all of the horses that belong to a 
particular owner.  
 

4.4. Moving Through The Tables - Using The Database 
Navigator 
 

 

Most of the entry screens used in this system have what is called a “Navigation Bar”, which looks like this: 
 

 
 
 
When the term “current record” is used, it means the record (or information) that is displayed on the screen.  

 

The system is designed to save any changes made to the entry screen when you leave.  So, if you make a 
change to a horse, and then page forward using the navigation bar, your changes are automatically saved.  It 
is still good practice to save your changes by clicking the “save” button on the toolbar. 
 

4.5. Locating Records 
 

 

There are two methods of looking up data in the various entry screens.  The first is a search, and is indicated 
by a small button with a blue “S” next to the field it’s available for, as follows: 
 

 

Search button 
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 Click this button to activate the search. 
 

Clicking on this button will display another screen, asking for the ID, class number, etc. you wish to search for.  

 
 

 

The purpose of a search is to position yourself on a particular record.  If, for example, you wanted to go 
directly to class number 12345, you would click on this button, enter the value in the screen that appeared, 
and click “OK”. 
 
 
 
 
The other method of looking up data is a “find”, and is designated by a button with a pointing hand on it, as 
follows: 
 

 

 

Find button 

Click this button to activate the search.  

 
 

 

The purpose of this type of button is to give you choices when filling a field.  For example, you have just 
entered a new horse, and need to input the owner Id.  If you don’t know the Id, you can click on the “find” 
button, which will present you with a screen of owners that you can choose from.  Choosing an owner from 
this screen fills in the appropriate Id number in the field you were working on. 
 
 
 
 
There is an additional filter available on the owner screen.  The top of the first tab of the owner screen looks 

like this: 
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5. How Do I Set Up A Show For The First Time? 
 

 

The best way to begin a new show is to proceed in this order: 
 

1. Enter your Administrative information for the show 

2. Enter your classes 

3. Enter your owners/members using the Owner entry screen (File-Owners).  Fill in all information 
pertinent, including the checkboxes for handler, trainer, owner, etc.  You will only use the first page of 
the owner screen in this step.  

4. Enter your horses using the Horse entry screen (File-Horses/Ponies).  Fill in all pertinent information , 
including the height, sex, birthdate, and foundation number if applicable.  There are some built in edits 
in the system that can cause you problems down the road if you don’t fill these fields in.   

5. Enter your entries, see How do I make entries? 

6. Enter and assign your judges, see How do I manage judges tasks? 

7. Print whatever listings are needed for the show 

 

 

5.1. Administrative Work First 
 

 

Customizing the System 
 
How to log in to the Show Management Administration Screen 
 
How to add the show name and the type of show to the splash screen 
 
How to customize owner accounting data 
 
How to use the system's accounting feature 
 
How to use the system's security feature 
 
How to set the system's auto-edit function 
 
 

Backing Up, Restoring, and Initializing Data 
 
Making a backup 
 
Automatic backup 
 
Restoring data 
 
Initializing data 
 

5.1.1. How Do I Customize The System? 
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There are multiple ways in which you can customize this system.  They are: 
 

 Customize the splash screen and the titles on the various entry screens, see Adding The Show Name 
And Type Of Show 

 Customize the accounting data on the Owner Screen, see Customizing Owner Accounting Data 

 Use the system's internal Accounting Feature 

 Customize the system's internal password protection, see Using the Security Feature 

 Set the system's Auto-Edit Function 

 Import owners and horses from the office (optional) 

 Import previously used classes or show information into your current show. (see the NOTE at the 
bottom of Making A Backup) 

 

All of these features can be ultimately controlled by logging in to the Show Management Administration 

Screen.  

 

 

5.1.1.1. Logging In To The Show Management Administration Screen 
 

 

Click on the “File” option on the top left.  Choose the “Administration” option, then choose “Show 
Management Screen”. 
 

 
 
 

The following screen will appear: 
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Click this button first 

You will then be prompted for a password. Enter the password you have been given, and click "OK". 

 

 

 

You will now see the previous screen, only with data in it. You are now logged in.  

 

5.1.1.2. Adding The Show Name And The Type Of Show 
 

 

By default, the splash screen (the first screen you see when you activate the system) looks like this: 
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You can customize the show name (first line at the top left, above “File-Reports-Tools-Help”), and the two 
large lines that appear on the main portion of the screen.  For example, we can customize this screen to 
appear as follows: 
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To customize the splash screen, perform the following steps: 

1. Activate the system by double-clicking the system icon on your desktop, or by searching for the 

program “EQUIENTRAMHA.EXE” and double-clicking it. 

2. Log in to the Show Management Administration Screen. 

3. To modify the splash screen, you will change the top three edit boxes: 

 

 

Modify show name 

Modify this line to change the show name information. This field appears on every screen in the system, and in 
the heading of every report. The show name can be up to 30 characters long. 

 

 

 

Modify lines 1 and 2 on splash screen 

Modify these two lines to change lines 1 and 2 on the splash screen. Each line can be up to 20 characters long. 

 

 

 

Type of show checkbox 

Make sure you have the type of show selected. 

 

 

 

Click this button to save and exit 

Once you are satisfied with the verbiage you’ve added and the choices you’ve made, click on this button at the 

bottom right side of the screen to save and exit. 
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Your changes have now been saved, and you are returned to the splash screen.  Since the system reads the 

show name and line values before it displays the screen, you must close out of the system and come back in 

before your changes will be in effect. 

 

5.1.1.3. Customizing Owner Accounting Data 
 

 

The owner accounting data is presented on the “Accounting” tab of the owner screen (File-Owners), and when 
fully implemented, will look something like this: 
 

 

 

Simple fees 

Simple fees are one time charges for a single item.  For example, a sponsorship fee is a simple fee. There are 5 
simple fees that you can customize as you choose. 

 

 

 

Compound fees 

Compound fees are fees where one pays so much for so many items.  For example, if we have to indicate that 

an owner paid five entry fees of $35.00 each, we use a compound fee. There are 17 compound fees, but 8 of 
them are reserved for system use. 
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Checkboxes 

Checkboxes are simple yes/no indicators. You have up to 10 of these fields to customize as you choose.  

 

 

 

Database navigator 

For more information on using the database navigator click here. 

 
 

 

 

 

How to modify the accounting page 

To modify the accounting page (and the associated reports), log in to the Show Management Administration 

Screen. 

It should look like this:  
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Click the bottom middle button to display the accounting screen, and it should bring up the following screen: 
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"Reminder" checkboxes 

You can have up to 10 "reminder" checkboxes on the accounting screen.  To activate them, simply type in the  

description for the checkbox, such as "paperwork checked", "fees paid", etc.  If you do not wish to use a 
particular checkbox, simply leave it blank or "Not Defined'. 

 

 

 

Single fee boxes 

You can have up to 5 "single fee" boxes.  These would be used for things like sponsorships, advertising, etc.   
They are used to accept a single amount of money.   If you do not wish to use a particular single fee, simply 

leave it blank or "Not Defined'. 

 

 

 

Compound fee boxes 

There are 15 "compound" fees (fees where you have so many items at a fixed price), but some are reserved for 

various entries.  
  

Hover your mouse over the fields to see if they are supposed to be assigned a particular value.  The reserved 
fields are highlighted in yellow.  Examples would be various types of entries, stall fees, shavings, etc.  If you do 

not wish to use a particular fee, simply leave it blank or "Not Defined'. 
 

Please do NOT try to use the predefined fields for anything other than what they are labeled for. 
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Process updates Button 

Click this button to save your updates.  

 

 

 

Close/cancel Button 

Click this button to exit the screen. 

 

 

 

 

5.1.1.4. Using The Accounting Feature 
 

 

 

You have the option of maintaining all of the owner accounting information mentioned above manually, or 
having the system maintain it for you. Maintaining it manually means that you enter the correct amount into 
the accounting fields defined above. This means, for example, that you would be responsible for entering the 
correct number of open entries into the proper accounting field.  
 
To turn this on and off, log in to the Show Management Administration Screen and find the checkbox in the 

upper right hand corner that says "Use the system's built in accounting feature" as follows: 
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Built-in accounting feature checkbox 

To enable the accounting feature to have the system do this maintenance for you, simply check this 
box. To turn off this option, uncheck this box. 

 
 

 

It works like this: When the “use the system’s built-in accounting feature” checkbox is checked, some of the 

compound fee fields are reserved for the system as follows: 

1. Compound fee #1 is reserved for Open classes. 

2. Compound fee #2 is reserved for Amateur classes. 

3. Compound fee #3 is reserved for Youth classes. 

4. Compound fee #4 is reserved for COOL classes. 

5. Compound fee #5 is available for use. 

6. Compound fee #6 is reserved for Futurity. 

7. Compound fee #7 is reserved for one Futurity. 

8. Compound fee #8 is available for use. 

9. Compound fee #9 is available for use. 

10. Compound fee #10 is available for use. 

11. Compound fee #11 is reserved for  Gelding Incentive. 

12. Compound fee #12 is available for use. 

13. Compound fee #13 is available for use. 
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14. Compound fee #14 is available for use. 

15. Compound fee #15 is available for use. 

 

Whenever an entry into a class is made, the system looks at the class chosen, and determines which of the 

above criteria is met by inspecting the checkboxes, as shown below: 

 

 

Class selection checkboxes 

One of these checkboxes must be checked for the internal accounting to function properly.  If you add classes 

from the master class list, these checkboxes are already set.  If you add a class of your own, you will be forced 
to check on of the boxes. 

 

 

 

NOTE: It is not recommended to change your use of the internal accounting feature once you have started 

making entries. 

 

NOTE: If there are classes that you do not want to charge for (such as championship classes), be sure to 
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check the “No charge” button on the class screen.  This will keep the class from getting charged even if you 

are using the internal accounting feature. 

 

5.1.1.5. Using The Security Feature 
 

 

By default, there is no security on the system.  This means that anyone who logs into the system can change 
data, results, etc. The system does offer password protection to allow the show manager to restrict access.  
Currently, the following two options are offered: 
 

 Database access 

 Results access 

 

If you decide to not allow database access, the affected user will only be able to view system data.  Update 

access will be denied. 

If you decide to not allow results access, the affected user will not be able to enter or change placing results, 

even if they have database access. 

 

To implement password protection, you must do the following: 

 Turn password protection on 

 Assign passwords and rights. 

 

To turn on password protection, log in to the Show Management Administration Screen.  You will see the 

following: 
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Built-in security feature checkbox 

To turn the password protection option on or off, simply check or uncheck this box. 

 
 

 

  

Assigning passwords and rights 

 

To assign passwords, select the “Maintain passwords” option from the Administration menu item, as follows: 
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The following screen will appear: 

 

 

You must authenticate using the master password by clicking on the “Click this button to view/edit data” 

button.  The screen will then become active, as follows: 
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You may now use the database navigator to add records (for more information on using the database 

navigator click here).  Enter the password, and click the appropriate access rights checkboxes.  You may 

create as many passwords as you like. 

The master password cannot be erased. 

 

 

5.1.1.6. Setting The Auto-Edit Function 
 

 

By default, all of the data entry screens used in the system are “hot”, meaning that you can click into any of 
the fields available and change data.  While handy, this ability can also lead to inadvertent data loss.  If you 
would prefer to turn off the auto-edit function, there is a checkbox on the Show Management Administration 
Screen to do this, as follows. NOTE: You must log in to the Show Management Administration Screen to 
check or uncheck this box.  
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Automatic editing for the basic entry screen only checkbox 

This just applies to the entry screen itself. Use this checkbox to turn auto-edit off/on. 

 
 

 

Automatic editing for all entry screens checkbox 

This applies to any entry screen that you go to to make changes (Owners, Horses/Ponies, etc.). Use this 
checkbox to turn auto-edit off/on.Leaving auto-edit on is highly recommended. 

 
 

 

 

 

Once you turn off the auto-edit function, you will have to click the “edit” button on the database navigator to 

put the record into edit mode: 

 

 

Database Navigator 

For more information on using the database navigator click here. 

 
 

Edit Button 
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 This button enables the edit function. 

 
 

 

5.1.1.7. Other Available Options 
 

 

These other checkboxes allow you to further customize the system. NOTE: You must log in to the Show 
Management Administration Screen to have access to check or uncheck these boxes. 
 
 
 
 

 

 

Automatic backup checkbox 

To enable the auto-backup feature, check this box. When this box is checked, the system makes a backup every 
15 minutes. This option is HIGHLY RECOMMENDED. It is also recommended you make at least 10 backups. For 

more information, please click here.  

 
 

 

System prompt when class eligible for advancement checkbox 

The system can notify you when entries in a class are eligible to be moved up to another class, such as a 

championship class.  To do this, you must use what's called a promotion table, which is a list of classes 

indicating what class they would move up to.  For more information on this feature, click here. 

 

 

Use a dropdown box for rider field checkbox 



 28 

 You have the option of a dropdown menu or a search button for the rider field on the entry screen. It is HIGHLY 
RECOMMENDED you use a dropdown menu. To do so, check this box. 

 
 

 

5.1.2. How Do I Back Up, Restore, And Initialize Data? 
 

 

The show program software allows for the initialization, backup and restoration of your data tables.  The 
following definitions are used: 
 

 Backup – The copying of some or all of your data to another location, either on your computer, a 

network, or an external hardware device such as a flash drive. 

 (This system also has the option of an Automated Backup) 

 Restore – The retrieval and copying of some or all of your data tables from a previous copy to your 

current system. 

 Initialize – the deletion of data (such as entries) or the blanking out of values (such as checkboxes) of 

data, usually done before a new show is started. 

 

The general chain of events that could happen is as follows: 

1. A new show is begun. Data (such as class information, owner information, entries, etc.) is entered. 

2. Any customization to the show information, such as the show title, or any of the accounting fields is 

performed. 

3. During the data entry portion of the show, backups are performed so that if anything happened to the 

computer in use, your data is not lost. 

4. The show computer is damaged and rendered unusable. 

5. A new computer is procured, and the Horse Show software is reinstalled from the installation copy. 

6. Current show information is restored from your latest backup, and the show continues. 

 

5.1.2.1. Making A Backup 
 

 

Go to "Tools" tab and choose the “Backup tables” option. This screen will appear: 
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Database checkbox 

First, check this box to designate the files that you want to backup. 

 
 

 

 

*BEFORE YOU CLICK THE "BACKUP FILES" BUTTON* 

You always want to back up your data to a different folder than where your current data is, so you may have 

to create a new folder.  You can do this in Windows itself, or you can do that here. Before you backup your 

files, create a new folder to back up your data to. 

 

Example:  We wish to back up our data to a new folder on our C: drive called “Horse show backup data”. 
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Database checkbox 

Check the checkbox for the data you want to backup. 

 
 

 

Click here to highlight C: 

Double-click on the “C” drive in the directory box so that the C: drive is highlighted, and its subfolders are visible, 
as follows: 

 

 

 

Click here to enter a new subfolder name 

Enter the name of the new subfolder you wish to create, in our example we named it "Horse show backup data". 

 
 

 

Click here to create new subfolder 

Clicking here will create a new subfolder and make it the folder the system is pointed to for its backup location. 
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It should look like this:  

 

 

After you have the right folder chosen, then click on the “Backup files” button. 

 

NOTE:  For the more computer savvy, simply copying and pasting the "aspcdata.mdb" file is an alternate way 

to make a backup. This is especially useful if you wish to use your class list, owners, and horses for another 

show.  

 

5.1.2.2. Automatic Backup 
 

 

In addition to performing backups by using the “Backup tables” option under the “Tools” menu, you can set 
the system to perform automatic backups. This is particularly useful when making entries.  Automated 
backups run every 15 minutes. To enable the function, log in to the Show Management Administration Screen. 
 



 32 

 

 

Enable auto-backup checkbox 

Check this box to enable the automatic backup function.  

 
 

 

Specify number of backups to keep 

Enter a value here to specify how many backup copies should be maintained at one time. It is recommended 

that you keep at least 10 copies. You can keep up to 100 backups.  

 
 

 

Backups occur every 15 minutes, and are stored in a subfolder called “System backups”, which is found in 

your show program folder.  The files themselves are timestamped, and look like this:  “aspcdata-07-09-2018 

16-18-06.mdb”. 

NOTE:  These files will not appear when you attempt to do a restore through the “Tools” menu.  To restore 

one of these backups, do the following: 

1. In your show folder, find the file called “aspcdata.mdb” and rename it to something descriptive. 

2. Go to your “System Backups” folder, find the backup you want to use, right click it, and choose 

“Copy”.  This makes a copy of the database on the system clipboard. 

3. Go back to your show folder, right click, and choose “Paste”.  This copies the database to your show 

folder. 

4. Rename the backup to “aspcdata.mdb”. 

 

5.1.2.3. Restoring Data 
 

 

Go to the "Tools" tab and choose the “Restore tables” option. The following screen will appear: 
 

This option is similar to the backup option, in that you will check the boxes of the data you wish to retrieve, 

and select the folder where the data resides, as follows: 
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Choose what files you want to recover 

Check the boxes of the data you want to retrieve. 

 

 

 

Location of files you want to recover 

Select the folder where the data resides. You will want to ensure that the folder has been chosen correctly.  You 

can verify the directory by looking at the label just above the directory display box.  

 

 

 

Recover files button 

After selecting the type of data to recover and the location of the data, click this button to recover files.  
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Cancel button 

Click this button to exit the screen. 

 

 

 

 

5.1.2.4. Initializing Data 
 

 

Go to the "Tools" tab and choose "Initialize tables". The following screen will appear: 
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To initialize data, you would check the appropriate checkboxes for what you want to do then click "Proceed".  

For example, if you only wanted to delete all entries, you would only check the “Delete all entries” checkbox. 

 

Note:  The following checkboxes are used for the Regional and World shows: 

 The "Delete Best All-Around Horse" item 

 The "Delete Ultimate Gelding divisions" item 

 The "Delete Gelding Incentive Fund" item 

 The "Delete Super-Amateur" item 

 The "Delete Super-AOTE" item 
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 The "Delete youth teams" item 

 

IMPORTANT NOTE:  It is highly recommended to make a fresh backup before you initialize any data. 

 

 

5.2. How Do I Enter My Classes? 
 

 

A database of office classes has been defined for the use of office staff, which corresponds to the classes in 
your show. These office classes already have all of the proper selections made, dropdown lists populated, etc.  
You may use any of these classes and assign them their own specific show class number.  To do this, proceed 
as follows: 
 

1. Navigate to the class screen by choosing "Classes" under the "File" menu.  

 

 

First, click the plus to insert a new record 

For more information on using the database navigator click here. 

 

 

 

Second, enter your class number 

After you click the plus, enter your class number. 

 
 



 37 

 

Third, search for your office class number 

Click the "S" to the right of "Office class #" to search an office class. Enter the name of your class and then click 
"Select". 

 
 

 

 

5.2.1. Updating The Master Class Listing 
 

 

The master class list is maintained by the AMHA office.  Sometimes, new classes may be added, or some 
deleted, which means that you may have to update the class list.  To do this, perform the following: 
 
Click on the “File” option on the top left.  Choose the “Administration” option, then choose “Master Class 
Listing Screen”. 
 

 
 
 

The following screen will appear: 
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Print class listing 

Clicking this button displays an abbreviated listing of the master classes. 

 
 

 

Class search button 

Use this button to search for a class by it's number. 

 
 

 

Import (update) classes from the master class listing 

Clicking this button will allow you to update your master class listing from the most current office information.  

For more information on this, click here. 

 

 

 

 

5.2.1.1. Updating the master class listing detail screen. 
 

 

Upon clicking the "Import from updated master list" button, you will be presented with this screen: 
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Selection boxes 

The selection boxes allow you to choose what classes you want to update.  If you want them all, click in the top 

button next to the word "Import" 

 

 

 

This is the grid where the classes and their descriptions are listed. 

Write description here... 

 

 

Search field 
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 If you can't find the class you want, or don't know the class number, you can type it in here and click the "Find 
Next" or "Find Previous" button to search for it. 

 
 

 

Process Selections Button 

Click this button to begin the update process. 

 

 

 

Close/Cancel Button 

Click this button to close the screen. 

 

 

 

5.3. Entering Your Classes From A Spreadsheet 
 

 

Version 6.4 introduced the capability of creating your class records from a spreadsheet, rather than having to 
type them all in.  To do this, click on the “Import classes from spreadsheet” button in the toolbar on the Class 
Entry Screen (File-Classes). NOTE: Importing classes in this manner will overwrite any classes you 
have already entered. 
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Clicking the button will bring up a dialog box asking you to select your spreadsheet, as follows: 

 

 

Once you select your spreadsheet and click “Open”, a screen similar to this will appear, displaying your 

spreadsheet: 
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You now need to tell the program where your “go numbers” are, and where your office class numbers are.  

Remember that the top row, and the leftmost column are number 0, not 1.  In the example above, the column 

that has the “go number” would be column 0, the master class numbers would start in column 1, and the row 

where the data starts would be row 0 (the top one). 

Once this has been decided, you will click the “Proceed with import” button.  Messages may be displayed in 

the memo area in the middle of the screen.  These messages usually are indications of errors, such as a 

master class in the spreadsheet not matching what you have in your master class database.  These classes 

will have to be added by hand, as will non-rated classes that don’t have a master class assigned to them. 

 

5.4. Entering sponsorship information 
 

 

Sponsorship information for sponsored classes can be entered in two different ways: 
 

1. Go to each individual class and type in the sponsorship information. 
2. Import the information from an Excel spreadsheet. 

 

5.4.1. Importing sponsorship information from a spreadsheet 



 43 

 

 

If your sponsorship information is in a spreadsheet, it is a simple matter to use it to update your class list with 
the sponsorship information. 
 

 
 
Clicking this menu item will bring up a dialog box asking you for your speadsheet: 
 



 44 

 
 
 
 
Entering or searching for your spreadsheet and clicking the "Open" button will cause the following screen to 
appear: 
 

 
 
Clicking "Open" brings up the following screen: 
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You now have to tell the program where to start.  Follow the directions on the screen.  In this case, my filled 
in screen would look like this: 
 



 46 

 
 
Clicking the "Proceed with import" button gives us this: 
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Now, if we were to inquire class number 1, we'd see the following: 
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Processing results 

This area tells us if the import works or not 

 

 

 

 

File name box 

This where your excel spreadsheet name goes. 

 

 

 

5.5. How Do I Enter Owner Information? 
 

 

Under the "File" menu, go to "Owners" to get to the main owner information screen: 
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You can manually enter them using the database navigator. For more information on using the database 
navigator, please click here.  
 

 

 

Database navigator 

For more information on using the database navigator click here. 

 
 

 

Entry Information tab 

For more information please click here. 

  

 

Accounting tab 

For more information please click here. 

  

 

Classes entered as exhibitor tab 

For more information please click here. 

  

 

Classes entered as trainer tab 

For more information please click here. 
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5.5.1. Looking Up Owner Information From The Office 
 

 

 

Version 6.2 introduced the ability to update horse or owner/member information directly from an online copy 
of the Office Pedigree Database.  This eliminates the need to do a complete download and import when only a 
small amount of data is needed.  In order to use this functionality, establishing a connection to the remote 
office database is necessary.  This is accomplished from the main splash screen: 
 

 

 

This function is offered in two ways: 

1. When searching by Id/Registration number for a horse or owner, an option will be displayed in the case of 

an unsuccessful search.  This option will look like this: 

 

Clicking “Yes” will cause the online owner file to be searched for the owner record.  If found, the owner record 

will be added to the local database. 
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2. When displaying a record on the corresponding entry screen (File-Owners), updating can be initiated by 

clicking on the “Update from remote database” button on the toolbar: 

 

 

Update from remote database button 

You must be logged in to the remote office database for this button to appear. 

 
 

 

Checkmark will then appear to show all information is updated 

You must click the "Update from remote database" button first, then this checkmark will appear to show 
updating is done.  

 
 

 

 

5.5.2. Entry Information 
 

 

The second tab on the main owner entry screen (File-Owners) is "Entry Information":  This screen displays all 
entries that this member/entity is fiscally responsible for. 
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Database navigator 

For more information on using the database navigator click here. 

 
 

 

 

 

5.5.3. Accounting 
 

 

The third tab on the main owner entry screen (File-Owners) is "Accounting":  If you are using the system's 
built-in accounting feature, this screen will show the results of entries made, scratches processed, etc.  This is 
also where payments received are recorded. 
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Checkboxes 

This is where your custom checkboxes are displayed. 

 

 

 

Single fees 

This is where your "single fee" items are displayed. 

 

 

 

Compound fees 

This is where your "compound fees" are displayed.  If you are using the accounting feature, any entries or 

scratches are automatically reflected here. 
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Payments grid 

This is where payments will appear. 

 

 

 

Post changes to accounting 

Clicking this button will save your accounting data. 

 
 

 

Print statement 

Clicking this statement will print a statement for the displayed member/entity. 

 
 

 

Refresh charges 

Click this button to recalculate the accounting charges.  This can be useful after performing several scratches, 

adds, etc. 

 
 

 

 

For more information on how to modify the accounting page, please see "How to modify the accounting page" 
under  Customizing Owner Accounting Data. 
 
 
 

5.5.4. Classes Entered As Exhibitor 
 

 

The fourth tab on the main owner entry screen (File-Owners) is "Classes entered as exhibitor":  This screen 
will display any entries that have this member/entity identified as the exhibitor/handler for horses in this class. 
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5.5.5. Classes Entered As Trainer 
 

 

The fifth tab on the main owner entry screen (File-Owners) is "Classes entered as trainer":  This screen will 
display any entries that have this member/entity identified as the trainer for horses in this class. 
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5.6. How Do I Enter My Horses? 
 

 

Under the "File" menu, choose "Horses/Ponies" to get to the Horse/Pony Information Screen: 
 
This is the main entry screen for horses.  You can manually enter them using the database navigator. For 
more information on using the database navigator, please click here.  
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Database navigator 

For more information on using the database navigator click here. 

 
 

 

 

 

5.6.1. Looking Up Horse Information From The Office 
 

 

This program has the ability to update horse or owner/member information directly from an online copy of the 
Office Pedigree Database.  This eliminates the need to do a complete download and import when only a small 
amount of data is needed.  In order to use this functionality, establishing a connection to the remote office 
database is necessary.  This is accomplished from the main splash screen: 
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This function is offered in two ways: 

1. When searching by Id/Registration number for a horse or owner, an option will be displayed in the case of 

an unsuccessful search. This option will look like this: 

 

Clicking “Yes” will cause the online files to be searched for the horse record. You must specify the registry that 

you want to be searched for a matching registration number. If found, the horse will be added to the local 

database. 

2. When displaying a record on the corresponding entry screen (File-Horses/Ponies), updating can be initiated 

by clicking on the “Update from remote database” button on the toolbar: 
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Update from remote database button 

You must be logged in to the remote office database for this button to appear. 

 
 

 

Checkmark will then appear to show all information is updated 

You must click the "Update from remote database" button first, then this checkmark will appear to show 

updating is done.  

 
 

 

Owner search button 

Click this button to go to the name search screen to be able to search an owner/member name from the office 
database. See below.  

 
 

 

When searching for an owner/member name on the Horse/Pony Information Screen, you can search the office 

database by clicking the button displayed on the name search screen (from the owner search button): 
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Search Office database Button 

Write description here... 

 

 

 

 

5.7. Entering Horses And Owners Using Office Download 
Files 
 

 

Version 4.4 added the capability of importing both owner and horse data from the AMHA office registry.  The 
office creates master files on a weekly basis.  You can then request that these files be emailed to you and 
import them into your system.   

 

To import owner/horse data 

Choose the “Import owner/horse data” from the "Tools" menu, as follows: 
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Doing so will bring up the following screen: 



 62 

 

 

Click here to perform a backup 

It is highly recommended that you perform a backup before you import data.  Clicking this button will direct you 

to the backup routine. 

 

 

 

The office will create two data files: 

 Owners 

 AMHA horses 

When you import owners, the routine will search for an existing record, and if found, will update the record 

with the imported data.  This leaves the accounting data intact. 

 

After backing up your data (if you choose to do so), select the data that you want to import from the 

dropdown list, and click the “Click here to select your file and begin” button, as illustrated here: 
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First, use the dropdown 

First, select the data you wish to import from the dropdown list here. 

 
 

 

Then, click here to select your file and begin 

Then, select the file you want to import by clicking here. 

 

 

 

Cancel/Close button 

Click this button to leave the screen. 

 

 

 

Choose your data to import from your files:  
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Open button 

Click here to open the file. 

 
 

 

This will display the following screen: 
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Display of files importing 

This is a display of the first few records that you will be importing.  

 

 

 

OK button 

If things appear normal, click “OK”.  This will begin the import process.  There will be a pause of a few seconds 

while the file is loaded into memory, and then the progress bar will activate, and progress messages will be 
displayed in the text box.  The imports can take anywhere from a few seconds to several minutes, depending on 

the amount of data being imported. 
 

It is recommended that you not move off of the screen while the import is in progress.  Doing so will cause the 

progress bar to freeze.  The import will continue. 

 
 

 

Cancel button 

Click this button to exit the screen. 
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NOTE: If the files start to get cumbersome, there is a utility program which will delete any owners without 

any entries, and any horses without entries. For more information, click here. 

 

 

5.7.1. Deleting Owners And Horses With No Entries 
 

 

Go to the "Tools" menu and choose "Delete owners and horses with no entries". 
 

 
 
 
 
The following screen will appear: 
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Backup routine Button 

It is highly recommended you perform a backup before running this routine. 

 

 

 

OK Button 

Select whether you want to delete owners or horses and click OK to proceed. 

 

 

 

Cancel Button 

Click here to close and exit the screen. 

 

 

 

 

5.8. How Do I Make Entries? 
 

 

There are two ways of making entries in the system: 
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Standard entries 

Expedited entries 

 

 

5.8.1. Entries - Standard 
 

 

Standard entries are made by clicking on the “add record” button of the navigator bar of the Entry screen 
(File-Entries). To make an entry, you must first designate the person responsible for the bill. To do this, first 
click the button on the top that says "click to add or update" (to the right of "person responsible for 
payment").  
 
 

 

 

First, designate the person responsible for the bill 

To make an entry, you must first designate the person responsible for the bill. To do this, click the button that 
says "click to add or update". 

 

 

 

Add record button 

Clicking here presents a blank screen for you add a new record. For more information on using the database 

navigator click here. Before you can make an entry, however, you must designate a person responsible for 

payment. 

 
 

Scratch dropdown 

Click this button to scratch or unscratch the displayed entry.  Click here for more information. 
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Back number search button 

Use this button to search for a particular back number. 

 
 

 

Entry grid 

This is just a table view of all of your entries.  Clicking on one will cause it to be displayed above.  Clicking the 

"Only show entries in grid for selected back number" will restrict the grid to only entries for the displayed back 
number. 

 

 

 

 

In order to streamline the entry process, additional options were added to the toolbar by the navigator 

bar. These buttons allow you to: 

1. Add a horse to another class - Once you have filled in all of the necessary information for the first 

entry and saved it, clicking on this button will start a new entry and fill in all of the previously entered 

information except for the class number. 

2. Add more team horses to an entry - When making team entries, enter one of the horses completely 

(including checking the “team entry?” checkbox), and save the record.  You will then click on the “Add 

more team horses to an entry” button.  This will start a new entry record, bringing the class 

information and back number forward, allowing you to choose the next horse.  It is very important 

that you use this button when making team entries.  Using this button sets some indicators on 

the team records which allow the class sheets to print properly. 

3. Assign a back number to this horse - Once you have made all of the entries for a particular horse, you 

can click this button to assign a back number if you have not already done so.  Clicking this button 

brings up the following screen: 

 

 

Fill in the back number, and click “OK” to assign the back number to all entries for this horse. 
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5.8.1.1. Scratching/unscratching an entry 
 

 

To scratch or unscratch an entry, go to the Entry screen (File-Entries) and use the dropdown menu in the 
upper right corner: 
 

 

 

To scratch/unscratch a horse use this dropdown menu 

For more information on the types of scratches, click here. 

 

 

 

 

 



 71 

5.8.1.1.1. Types Of Scratches 
 

 

These are the types of scratches: 
 

 Office scratch - When someone contacts the office and announces their intention to scratch an entry. 

  This will result in the refunding of the entry fee. 

 Gate scratch - When someone announces at the gate they are not going to show. 

  This will result in the forfeiture of the entry fee (i.e. they still get charged for the entry). 

 No show - This is typically not used by AMHA. 

 

NOTE: NO SHOWS ARE MAINLY USED AT REGIONALS AND WORLDS 
 
 
 
 
 

5.8.2. Entries - Expedited 
 

 

The second way of making entries is to use the “Expedited entry” option under the "File" menu.  Choosing this 
option brings up the following screen: 
 

 
 
This screen is a combination of an entry screen, the horse entry screen, and the owner screen.  A “splitter” 

down the screen lets you show more or less of the screens by dragging it left or right. 

This screen allows you to make multiple entries on one screen.  You can choose from multiple exhibitors, and 

can assign financial responsibility for all charges.  This screen is useful when using the internal accounting 

system because you can make entries for office fees, stall/tack fees, late fees, etc. 
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5.9. How Do I Manage Judges Tasks? 
 

 

Judges tasks can be completed by choosing "Judges Maintenance" from the Administration option under the 
"File" menu, as follows: 
 

 
 
 
 

Choosing the “Judges Maintenance” menu item will display the following screen. First, hit the "Authenticate" 

button and enter your password to log in.  



 73 

 

 

Authenticate button 

Be sure to click this button first to log in by entering your password. 

 
 

 

Database navigator 

Use this to add judges. You may have as many judges as you wish. For more information on using the database 

navigator click here. 

 
 

 

Judge ID number 

Each judge should have an Id associated with them. This number may be an actual assigned number, or you can 

simply start with 1 for the first judge, and continue.   
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Assign classes to selected judge button 

For more information please click here. 

 
 

 

Clear judges from classes button 

Use this to clear the judges from all classes. For more information please click here. 

 
 

 

View class database button 

For more information please click here. 

 
 

 

Display classes for selected judge button 

Check to see what classes are assigned to a judge. For more information please click here. 

 
 

 

View class with no judges button 

Look for classes that have not had a judge assigned to them. For more information please click here. 

 
 

 

Assign call judges button 

To assign a call judge, click this button.  The system will look for any classes with three judges, and rotate the 

call judge between the three. To see the message you will get when this task is completed please click here. 

 
 

 

 

5.9.1. Assign Classes To Selected Judge 
 

 

Once your judges are entered (by using the database navigator at the top of the page, for more information 
please click here), you can assign them to your classes.  To do this, click next to the desired judge in the 
space on the left hand column to highlight the judge, as follows: 
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With the desired judge highlighted, click the “Assign classes to selected judge” button. NOTE: If this option is 

not available please authenticate by clicking the "Authenticate" button at the top of the screen and entering 

your password. The following screen will appear: 

 

 

Class range 

Enter the class range that you wish to assign the judge to. 

 

 

Indicate what number the judge is going to be in the class 



 76 

 Example: first judge, second judge... 

 
 

 

OK button 

Click to complete assignment 

 
 

 

Cancel button 

Click to exit the screen 

 
 

 

 

5.9.2. Clear Judges From Classes 
 

 

When clicking "Clear judges from classes", you will get the following screen. NOTE: If this option is not 
available please authenticate by clicking the "Authenticate" button at the top of the screen and entering your 
password. 
 

 
 
 
You can also clear judges from classes by using the Initialization routine. 
 
 
 
 

5.9.3. View Class Database 
 

 

When clicking "View class database", you will get the following screen: 
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You have the option of printing standard or alternate-format judges’ cards from this screen.  The cards will 
print with the judge’s name on it, and will designate whether or not the judge is serving as a call judge. Click 
here for samples of judges cards. 
 
 

5.9.4. Display Classes For Selected Judge 
 

 

Beginning with version 5.9, you are now able to print judges’ cards from the judges maintenance screen.  
From the judges maintenance screen, choose the “Display classes for selected judge” option (make sure you 
have selected your judge).  You will see the following screen: 
 

 
 
 
You have the option of printing standard or alternate-format judges’ cards from this screen. The cards will 

print with the judge’s name on it, and will designate whether or not the judge is serving as a call judge. Click 

here for samples of judges cards. 

 

5.9.4.1. Sample Judges Cards 
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Standard judges cards look like this: 
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Alternate judges cards look like this: 
 

 
 
 

5.9.5. View Class With No Judges 
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When clicking "View class with no judges", you will get the following screen. If judges have been assigned to 
all classes this screen will be empty.  
 

 
 
 
 
 
 

5.9.6. Assign Call Judges 
 

 

To assign a call judge, click "Assign call judges".  The system will look for any classes with three judges, and 
rotate the call judge between the three. You will get the following screen to let you know the task has been 
completed: 
 
 

 
 
 
NOTE: If this option is not available please authenticate by clicking the "Authenticate" button at the top of the 
screen and entering your password. 
 

5.10. How Do I Manage Multiple Shows? 
 

 

If you will be using this software to manage multiple shows, there are some tricks you can use to make things 
easier on yourself. These tricks involve implementing a good scheme of file folders, and utilizing the 
initialization, backup and restore functions wisely. 
 

 Create a folder named something like “Horse shows 20xx”, where “xx” is the year.  Then, create 
subfolders under that for each show you are going to manage.  Finally, create a subfolder called 
“current show”.  This will be the folder that will be your working directory for each show. 
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 Whenever you make a backup of a show, direct the backup to one of the named subfolders. 

 When the current show is finished, make one final backup to the named folder. 

 Initialize your data in your current folder to get ready for the next show.  That way, you are always 
working out of the “current show” folder, but can refer to any of the named folders for reference. 

 

Also see: Example of managing multiple shows efficiently 

 

5.10.1. Example Of Managing Multiple Shows Efficienty 
 

 

Scenario:  I have three horse shows that I am responsible for (The Midwest, the Diamond Rio, and the Charity 
Youth), and I want to use the software to manage them.  However, there are many similarities between the 
shows, and I don’t want to re-enter the same information multiple times. 
 

Create folders on your computer 

As mentioned previously, we need to create a folder structure to handle our shows.  Note that you can create 

these folders anywhere on your computer you have access.  In our case, I create them under the C: drive: 

 

 

 

I have created on main folder directly under the C: drive called “Horse shows 2013”.  I then created four 

subfolders: one for the current show, and one named folder for each show I’m responsible for.  Note that I 

named my current show folder “_current show”.  Putting the underscore at the beginning of the name ensures 

that this folder always appears first.  This will be the folder that you will install the software into, or copy data 

from another show into. 

 

First show - Customize and initialize the tables 
 Now that I have installed or copied data into my current working folder, I first need to change the 

show name. See Adding the show name and the type of show. 

 I now need to initialize my data.  To do this, go to the "Tools" tab and choose "Initialize tables". I am 

going to assume that I’m starting with a clean install, so I will initialize everything, as follows: 
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 I now enter the data I need for my current show, such as class numbers and descriptions, owner 

information, horse information, and entries. 

 I periodically perform backups to my named folder for this show by going to the "Tools" tab and 

choosing "Backup tables", as follows: 
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Manage the show using the software 
Continue using the software to manage your show, such as making entries, printing class sheets, etc. 
 

Get ready for the next show 
Now that my first show (Charity Youth) is finished, I now begin to prepare for the next show, which is the 
Diamond Rio.  I want to use the same classes, owners, and horses in this show, but all of my custom 
checkboxes and fees need to be redone. 

 

Second show - Customize and initialize the tables 
 The first thing that I need to do is perform one more backup (Tools-Backup tables), as follows: 



 84 

 

 

 Now that I have installed or copied data into my current working folder, I first need to change the 

show name. See Adding the show name and the type of show. 

 I now need to initialize my data given my circumstances dictated above. To do this, go to the "Tools" 

tab and choose "Initialize tables". 
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 I now have a system that has my existing classes, owners, and horses.  All payments and scoring 

information has been erased. 

 Customize the accounting checkboxes and fees as described in Using the accounting feature. 

 You are now ready for the next show. 

 

Get ready for the third show 
I have followed all of the above steps, and have successfully concluded the second show.  I have also made 

my final backup of the show.  My final show (Midwest) is a basic copy of the Diamond Rio. 

 

Third show - Customize and initialize the tables 
Since I want virtually everything to stay the same, all I have to do is modify the show name and initialize the 

data.  

Now that I have installed or copied data into my current working folder, I modify the show name as described 

in the section entitled Adding the show name and the type of show.  

Then I initialize (Tools-Initialize tables): 
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You are now ready to work the third show. 
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6. How Do I Manage My Entries During A Show? 
 

 

How to scratch or disqualify an entry 
 
How to split large classes 
 
How to promote entries to another class 
 
How to scramble the order of go 
 
 
 

6.1. Scratching Or Disqualifying An Entry 
 

 

There are a couple of ways to scratch an entry.  
 
The first is by going to "Entries" under the "File" tab. You will see this screen: 
 

 
 
 
Find the "scratch this horse" dropdown menu in the upper right corner. This will give you the option of an 
office scratch, a gate scratch, or a no show. If a horse is scratched on accident, simply click "undo". For more 
information on the types of scratches click here. 
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The other place you can enter a scratch or disqualification is on the "Record judging and who showed" screens 
under the "Tools" tab.  
 

 
 
 
 
Find where it says "Change Entry Status" in single judge/multiple judge placing: 
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Here you will be given these options:  
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6.2. Splitting A Class 
 

 

Sometimes it becomes necessary to split a large class into smaller classes to make the showing and judging 
easier.  The class numbers, even though they appear to be whole numbers, are actually decimals.  This means 
that we can create “subclasses”. For example, if class 45 has a large number of entries, we can automatically 
create two or more subclasses for class 45 numbered 45.1, 45.2, etc.. 
 
To split a class, go to the “Tools” menu and choose the “Split a class into smaller classes” option.  You will be 

presented with the following screen: 
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Enter the class that you want to split, and tab or mouse click into the next field.  The system will automatically 

look for subclasses, and fill in the next entry fields, as follows: 
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Subclass numbers 

You can either accept these subclasses, or you can choose other numbers by filling in the fields. 

  

 

OK button 

Once you have chosen your class numbers, you should click the “OK” button.  The system then looks 
at the class to split, and begins copying entries from the class into the subclasses, alternating between 
them.  The first entry (by back number) in the large class goes into the first subclass, the second entry 
goes into the second subclass, and so on. 
 
The internal accounting function ignores these subclasses. 

No entries are removed from the class that you’re splitting. 

 
 

 

Cancel button 

Click this button to cancel and exit the screen. 
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6.3. Promoting Entries to Another Class 
 

 

 

Quite often, winning a class makes an entry eligible for a championship class.  To facilitate this, “Promote” 
buttons have been placed in various places. One can be found on the second tab of the Class screen (File-
Classes-Entries in the class): 
 

 
 
 
 
Others can be found on the various result entry screens ("Record placings and show showed" under "Tools"), 

such as this one for multiple judges: 
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Clicking on the "Promote" button will display the following: 
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One of two scenarios is possible: 

 If you have entered your  classes into the promotions table, the first edit box will be filled in with the 

appropriate class number.  For information on setting up your classes in the promotions table, click 

here. 

 If you did not create your classes using the promotion table, then the edit box with the class number 

to get promoted to will be blank.  It will be up to you to provide the proper class number. 

 

6.3.1. Viewing/Maintaining The Promotion Table 
 

 

 

In the section entitled Promoting entries to another class, We mentioned that if you had predefined what 
classes would promote to what championships or semi-finals, the system could fill that in for you.  Here's how 
to do it. 
 
In order for the promotion process described above to work properly, the table holding the promotion 

information must be correct.  The promotion table is basically a list of classes, and what class (if any) the top 

two placings should be entered in (“promoted”).   

You may view and edit this table by going to File-Administration-Promotion Table.   

Choosing this option will display the following screen: 

 

 

From this screen, you can add, update or delete any promotion information associated with your show.  You 

can also print a listing of your promotion table so that you can verify that everything promotes correctly.  Click 

here for a sample of the Promotion Table report. 

 

To add a promotion record, do the following: 
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1. Click the "Plus" sign on the DBNavigator.  (For more information on the DBNavigator, click here.) 

2. Enter the class number that will be promoted, and press "Enter" 

3. Enter the class number that the class will be promoted to, and press "Enter" 

4. Enter the number of entries that should be promoted, and click the "checkmark" icon on the 

DBNavigator 

 

To change an existing promotion record, do the following: 

1. Scroll through the grid and find the class number that you need to change.  It should appear at the top 

of the screen. 

2. Change either the "To" class number, or the "number to be promoted".  Do NOT change the "From" 

class number. 

3. Click the "checkmark" icon on the DBNavigator to save your change. 

 

6.3.1.1. Sample Of Promotion Table Report 
 

 

 
 

 

 

 

6.4. Scrambling The Order Of Go 
 

 

To scramble the order of go in a certain class, go to "Class sheets/# entered per class" under "Reports".  
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The following screen will appear: 
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Note that the Order of Go listing is automatically scrambled. 
 

 

Scramble option should only be used on one class at a time 

Starting class and ending class should only encompass one class to use the scramble function. 

 

 

 

Scramble checkbox 

Check this box to scramble entries on sheet and then click OK.  

 
 

 

The following box will appear after you click OK. 
 

 
 
 
To see and review the order before printing, click "Yes". 
 
 
The following screen will appear: 
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Double click here to change the # as desired 

Double click the numbers in this right hand column to change the number so the order appears as desired. 
Decimals are acceptable. (Example, if you wanted a certain horse to be first in the order you could enter .5 in 

this column) 

 

 

 

OK button 

Click here to go to a Print Preview. The order that they appear in the grid before you press OK is the order they 

in which they will print. 

 
 

 

 

The print preview will look like this below: 
 
NOTE: THIS SCRAMBLE IS NOT PERMANENT, SO PLEASE PRINT SEVERAL COPIES OF SHEETS NOW. IT IS 
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NOT SAVED, SO IF YOU GO BACK AND SCRAMBLE AGAIN IT WILL BE IN A DIFFERENT ORDER.  
 

 

 

Print button 

Click here to print. Reminder, print multiple copies now as this is not saved and not permanent. If you have to 

scramble again, the results will be different.  
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7. How Do I Enter Results? 
 

 

There are two ways that placings can be recorded in the system: 
 

1. Directly on the entry screen for the placing horse, see The Old Fashioned Way 

2. Using the utility which allows you to enter all of the placings for a particular class either with a single 
judge score of multiple judges scores 

 

7.1. The Old Fashioned Way 
 

 

Once you locate a particular entry that has placed in a class, you may edit the entry directly on the entry 
screen (File-Entries).  
 
Example:  Registration number A199176 has won 2nd place in class 11.  We want to record the placing.  We 

would first locate the entry: 

 

We would then enter an 2 in the placing field, and then save the record by clicking on the checkmark in the 

database navigator bar at the top of the screen. For more information on using the database navigator please 

click here. 

This method of entry can be used anytime on any entry. It can be used to correct mistakes as well as 

performing the initial entry. This is a slow and tedious way to record placings, however. 

 



 102 

7.2. Single Judge Score 
 

 

The best method of entering placing values would be to use one of the utilities provided by the system under 
the “Tools” menu item.  For classes utilizing one judge scoring, the entry screen you want to use to record the 
placings is labeled as “Record placings and who showed”. 
 

 
 

This will bring up a screen that looks like this:  
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This screen allows you to enter up to 10 placing values for a particular class.  (If you have more than 10 

placings, you would enter the first 10, post them, and then clear the screen).  You would enter the class 

number, and then the back number and the placing associated with the back number. 

If you are recording information on entries that showed in the class but did not place, you can enter their back 

number and leave the placing field blank.   

Once all of your entries have been entered, click on the "Post" button to save them. 

 

 

7.3. Multiple Judge Scoring 
 

 

The best method of entering placing values would be to use one of the utilities provided by the system under 
the “Tools” menu item. For classes allowing multiple judge placing, you will want to use the one that says 
“Record placings and who showed (multiple judges)”. 
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This will display a screen like this: 
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You would cycle through this screen for as many judges as you have placing the class.  Choose your judge 

from the dropdown list at the top. 

 

7.4. A better way to enter multiple judges scores 
 

 

For classes allowing multiple judge placing, you will want to use the one that says "Post results for multiple 
judges".  This serves as a replacement for the 
“Record placings and who showed (multiple judges)” option, although that option remains available. 
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This will display a screen like this: 
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The idea of this screen is that you can see all of your judges scores at once, thus cutting down on missing 

results.  Once you enter your class number and press the "Enter" key, you will see something like this: 

 

 

 

Class number field 

Enter your class number that you want to post results for here. 

 

 

 

Back number grid 

This is where the back numbers/results appear after you leave the class number field.  In this example, judge 1 

has 10 results entered. 

 

 

 

Post button 

Click this button to save your results. 
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Duplicate these entries 

If all of the judges have scored the class identically, you can enter the results for judge 1, click this button, and 
then click the Post button.  The system will automatically fill in the remaining judges scores for you. 

 

 

 

7.5. Three Judge Average Score 
 

 

This scoring method involves capturing the scores of three separate judges and combining their scores to 
determine the placings.  The entry screen looks like this: 
 

 
 

The Prepare button 
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 Before a class can be scored, it must be prepared.  You do this by clicking the "Prepare this class for judging" 
button.  The following screen will appear: 

 
 

Enter your class number in the box, and click the "OK" button. 
 

Caution:  If when preparing your class, you receive a message indicating that the class has already been 
prepared, use caution.  If you accidentally prepare a class after it's been judged, you will erase the judging 

records for that class.s 

 

 

 

  

 

The Calculate button 

Once all of your scores have been entered, you must calculate the placings.  you do this by clicking this button.  

To see a sample of this screen, click here. 

 

 

 

The post button 

Clicking this button saves your results.  It is the same as answering "Yes" to the prompt shown in the 

screenshot above. 

 

 

 

Options 

These options help to streamline the judging process.  For example, at the World show, the ring announcer has 
a monitor which displays the announcers report which he/she uses to announce the winners.  By clicking the top 

two options, the report will automatically appear on the screen after results are posted.  If these options are not 
chosen, the ring secretary will have to manually print the announcers report. 
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The scoring method used is as follows: 
 
1st place - 10 points 
2nd place - 9 points 
. 
. 
5th place - 6 points 
. 
. 
. 
10th place - 1 point 
 
 
 

7.5.1. Screen with scores 
 

 

Before calculation: 
 

 
 
 
After clicking the "calculate scores" button: 
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You can see the scores on the right hand side of the screen.  The system automatically prompts you to save 
your results.  Unless you see a problem, click "Yes" 
 

7.6. Scoring jumping classes 
 

 

Jumper classes are scored differently than other classes because they depend on the height of the jumps, and 
the number of faults received.  To help with the scoring, a special screen was created.  You can reach it here: 
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Clicking this option brings up the following screen: 
 

 

 

Class number 

Enter your class number here and press the "Enter" key 
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Jumper information 

For each run, enter the back number, the height (or the level number), and the number of faults. 
 

A bit of explanation regarding the height: 
 

If you  are measuring the actual height that the horse jumps, enter it into the height/level field.  If you don't 
measure the height, then you will fill the field with the "level" of the jump.  The first round of jumps would be 

level 0, the next one level 1, etc. 

 

 

 

Jumper results 

The results are sorted automatically and appear here. 

 

 

 

Transfer results button 

When all runs have been completed, click this button to transfer the winners into the scoring pane.  Then, click 
"Post" to save your results. 

 

 

 

Delete records from class 

If you need to clear all jumping records from a class, double-click on this icon. 

 

 

 

Delete single line 

If you need to just delete one line item, double-click in the leftmost cell (the grey box) in front of the line to be 
deleted. 

 
 

 

Note:  You can edit any line by clicking on the cell you want and changing its value. 
 
Click here for an example of entering and scoring jumper classes. 
 



 114 

7.6.1. Jumper class scoring example 
 

 

In this example, we will use class 44, which has the following horses in it: 
 
161 
214 
331 
347 
348 
606 
627 
747 
749 
757 
 
Note that when entering, you want to use the "Enter" key.  Using the mouse on this screen will slow you 
down. 
 
Ring number 161 gets through with 0 faults, as does 347,606,627, 749, and 757.  All the others had at least 4 
faults.  So, after the first run, the screen would look something like this: 
 

 
 
The next run is for the 6 6 horses with 0 faults.  Notice they are sorted to the top of the results grid. 
 
During this run (level 1), only 606, 747, and 757 get through with no faults.  The results screen will now look 



 115 

like this: 
 

 
 
We have three horses left with no faults, so we do another run.  This time, only 757 makes it through.  Here 
are the results: 
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We now have our final results.  We now click the "Transfer" button to move the records to the left side of the 
screen and assign placings: 
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You would now click on the "Post" button to save your results. 
 
Note that in jumper classes, ties are allowed. 
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8. How Do I Manage Things After A Show? 
 

 

1. Check the results 

2. Error listings 

3. Prepare and send results to the office 

4. High points 

 

 

8.1. Error Listings 
 

 

Go to "Print error reports" under the "Reports" tab:  
 

 
 
 
 
There are 3 possible error reports: 
 
1. Print classes/horses with no entries 
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2. Print judges with no results 
 

 
 
 
 
3. Print classes with no results 
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8.2. Preparing And Sending Results To The Office 
 

 

Show results can now be sent as spreadsheets to the office.  Doing so allows the office staff to import the files 
directly into the Pedigree system without having to manually enter them.  To create these spreadsheets, go to 
the "Tools" menu and choose the option “Create files of results for the AMHA office”.   
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You will see the following screen: 
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Step 1 

Click this first. This creates a file of back numbers. 

 

 

 

Step 2 

Click this after Step 1 is completed. This prepares judges information. While this step does not create a file, it 

performs some functions needed in the next step. 

 

 

 

Step 3 

Click this after Step 2 is completed. This creates a file of results.  

 

 

 

Step 4 

Click this after Step 3 is completed. This creates the youth and amateur high points spreadsheets. 

 

 

Close/Cancel button 
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 Use this button to exit the screen. 

 
 

 

 

1. Click the button labeled “Step 1”.  This creates a file of back numbers. 

2. Click the button labeled “Step 2”.  While this step does not create a file, it performs some functions needed 

in the next step. 

3. Click the button labeled “Step 3”.  When this step completes, you will see the following screen: 

 

This screen gives you the opportunity to review your spreadsheet of results before you email it.  Simply check 

the box that says “Open file” and then click "OK". 

 

4. Click on the “Step 4” button.  This creates the youth and amateur high points spreadsheets. 

5. Email the spreadsheets created (found in your show folder) to the office. 

 

 

8.3. High Points (local shows) 
 

 

Access high points reports by going to "Amateur Reports" and "Youth Reports" under the "Reports" tab: 
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You will then have the choice of listing amateur/youth exhibitors with points by name or by handler/horse. 
 
 
For example, in listing amateur exhibitors with points by name, you will get the following screen: 
 

 

 

First, check this box 

Click here first. 
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Then click OK 

Click here to proceed to the print preview.  

 
 

 

Cancel button 

Click here to exit the screen. 

 
 

 

 

 

Click here for a sample high points report. 
 
 
 

8.3.1. Sample High Points Report 
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8.4. High Points (regional and World shows) 
 

 

Regional and World shows have a more extensive set of high point routines.  They are accessed from the 
reports menu: 
 

 
 
 
To see the Youth/Special needs screen, click here. 
 
To see the Amateur screen, click here. 
 
To see the Miscellaneous screen, click here. 
 

8.4.1. Youth/Special needs screen 
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8.4.2. Amateur screen 
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8.4.3. Miscellaneous screen 
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9. How Do I Get Ready For The Next Show? 
 

 

Now that the first show is complete, it's time to get ready for the next show.  If you find that your next show 
is similar to the first show, there are some shortcuts you can take which will save you time. 
 
At a minimum, you should do the following: 
 
Make a backup 
 
Initialize your database for the next show 
 
 
If you feel comfortable with your computer, you can simply copy the ASPCDATA.MDB file from your existing 
folder to your new show folder.  Then, proceed as in Setting up a show for the first time. 
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10. How Do I Print Listings? 
 

 

Whenever a report is printed, it is usually sent to a screen preview window so the report may be viewed 
before printing.  This allows for the review of the report for accuracy as well as for selectively printing only 
certain pages of the report. When you are ready to print, you can find the "print" button at the top left corner 
of the screen. Use the "export to file" button to the right if you wish to export the information to a file instead 
of physically printing. It is possible to export to file by using the "print" button as well. See below for more 
information.  
 

 

 

Print button 

Click this button to go to the print dialog box. You can still export to file by clicking this button, please see below.  

 
 

 

Export to file button 

Clicking here will allow you to save and export to a file instead of physically printing. See below for more 

information. 

 
 

 

You will see a dialog box like this when you click the print button: 
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To save your output to a file, click on the “Export” button. This is the same thing you will see if you click the 

"Export to file" button: 

 

 

Clicking on the drop down arrow by “Type” will give you the choices of file types: 
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Drop down arrow 

Clicking here will give you the choices of different file types.  

 
 

 

Choose the file type you want, enter the file name (you can click on the browse button to the right of the file 

name field to browse to a particular folder), and click “OK” to print to file. 
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11. How Do I Manage Database 
Repair/Maintenance? 
 

 

Under normal circumstances, your database requires little maintenance.  There are, however, instances when 
your database can become corrupt.  These instances include: 
 

 Shutting down your computer with the system active 

 Power interruptions which cause your computer to shut down unexpectedly 

 Using a program other than the AMHA Show Program to open the database. 

 

If your database becomes corrupted, there is a routine under the "Tools" menu called "Database repair" which 

will allow you to attempt to repair it: 

 

 

Clicking on this option will first display a message dialog: 
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Errors will occur if the database is open when you try to repair it.  It is also a good idea to backup your 

database (even though it’s damaged) before attempting a repair. 

 

Closing the above dialog box will reveal the repair dialog box: 

 

 

OK button 

Click OK to run the repair utility. 

 

 

 

Cancel button 

Click here to exit the screen. 

 

 

 

 

NOTE: On rare occasions, owner information can get corrupted in entries.  When this happens, you can use 

the “Validate owner data in entries” option on the “Tools” menu to validate and correct any errant owner 
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information in the entries. 
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12. Is There Anything Else I Need To Know? 
 

 

This topic consists of system details 
 
Transaction logging 
 
Restrictions 
 

12.1. Transaction Logging 
 

 

The system automatically logs transaction information when a record is added, updated, or deleted.  This 
transaction log is called aspclogfile.csv, and is located in the home directory of the computer in use (normally 
c:\users\username).  The contents of this file are as follows: 
 

 Date/time of the transaction 

 The screen that the transaction was completed from.  The choices are as follows: 

  ▪   Classes 

  ▪   Owners 

  ▪   Horses 

  ▪   Entries 

  ▪   Expedited Entries 

  ▪   Results 

 Type of transaction.  The choices are as follows: 

  ▪   Add 

  ▪   Add/Update 

  ▪   Update (Results only) 

  ▪   Delete 

 Key field.  This identifies the record that was modified.  The choices are as follows: 

  ▪   Classes – the key is the class number 

  ▪   Owners – the key is the owner id 

  ▪   Horses – the key is the horse registration number 

  ▪   Entries – the key is the class number/back number 

  ▪   Both types of results – the key is the class number/back number/placing 

  ▪   The computer name that the transaction took place on 
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This file can be opened and examined using Excel, Wordpad, Notepad, or Word. 

This file can be deleted by using the initialize option on the tools menu.  See Initializing Data for more 

information. 

 

12.2. Usage restrictions 
 

 

This program has been purchased by the American Miniature Horse Association for its use and the use of its 
members in conducting AMHA horse shows.  This software may not be given, sold, or transferred to anyone 
else, nor can an AMHA member utilize this software to run other shows without the express permission of W. 
Mark Anderson Computer Consulting. 
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13. I Need Help 
 

 

If you still need help, please contact me.  I will be glad to walk through things with 
you over the phone, through zoom, or depending on distance, in person. 
 
You can get my contact information from the AMHA office. 


